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« Comme le programme a été réalisé à l'origine pour mes enfants, il y a très peu de texte. L'utilisateur
devra composer avec les nombreux boutons et icônes à la place.

You pouvez réaliser des constructions en utilisant les briques standards, les briques toits et les briques
spéciales comme celles représentant des fenêtres et des portes. Vous pouvez choisir la couleur de
chaque pièce et même la modifier par la suite.

La première façon d'assembler les briques est d'utiliser la souris en les sélectionnant dans la fenêtre de
droite puis en les déplaçant dans la fenêtre de visualisation. En mode normal ("Safe mode" en anglais),
chaque brique se place par dessus une brique précédente. Il est impossible de la placer dans les airs ou
entre deux autres briques. Le mode normal peut être annulé à partir du menu de configuration (Icône
Roulement). »



La barre d'outils située en haut du programme

 Quitte le programme

 Commence une nouvelle construction

  Ouvre une construction enregistrée ou un sous-assemble à ajouter

 Enregistre une construction ou la sélection d'un ensemble

 Sélectionne une partie de la construction et l'enregistre sous forme d'image au format BMP ou
JPG

 Imprime une simple copie d'écran

 Menu pour configurer le logiciel

 Modifie l'angle de vue de la construction

 Affiche ou non les points de fixation sur les briques (studs). Accélère la modélisation sur de vieux
PC quand l'option No Studs est sélectionnée.

 Remplit ou non les faces de la construction. Là encore, la modélisation est plus rapide si aucun
rendu n'est à réaliser sur les faces.

 Aperçu 2D depuis la base.

 Grossit ou rétrécit la vue de la construction à l'écran.

 Redessine la construction à l'écran. Cela peut-être nécessaire après utilisation lorsque l'option Z-
level n'est pas sélectionnée.

 Permet d'abandonner le mode insertion de briques (NDT : la touche [Echap] agit de la même
façon).

 Rend transparentes les briques (NDT : utile pour simuler des vitres).

 Affiche ou non les points de fixation sur les briques à sélectionner

 Permet de choisir quelle couleur appliquer à la surface des briques

 Adresse de l'auteur du programme (Anders Isaksson) et liste des personnes qui l'ont aidé à
améliorer le logiciel.



 La barre d'outils située en bas du programme

 Briques vues de dessus

 -> Blocs vus selon des angles prédéfinis

 Briques vues de côté

 Restaure l'angle de vue initial de la construction tel qu'il avait été enregistré

 Permet de modifier la taille des points de fixation. Normal pour des points complets, Halp
pour la moitié et Fine pour 1/24 ème

 L'option Z-level. Permet d'afficher une à une les différentes étapes de la réalisation.
Utile quand il s'agit de faire un réajustement une fois que la construction a été achevée.

 Dimensions de la base en nombre de points de fixation. Si vous saisissez 0 pour l'un
des deux nombres, cela a pour effet de supprimer la base. Appuyez sur la touche [Entrée] pour valider
la saisie.

 Sélectionne la hauteur de la base entre deux modèles (haute ou courte)

La barre d'outils située sur le côté droit

 Un clic gauche sélectionne la couleur des briques, un clic droit sélectionne la
couleur du fond de la fenêtre de visualisation.

 -> Sélectionne les différentes collections de briques disponibles 

-> Un clic gauche sélectionne la brique en mode insertion. Il suffit de la faire
glisser à l'endroit désiré dans la fenêtre de visualisation. Un clic droit fait
apparaître un menu contextuel pour éditer la pièce.

Opérations à l'aide de la souris dans la fenêtre de visualisation

Clic gauche + Touche [Majuscule] -> Sélectionne une brique de la construction pour la déplacer.
Attention, quand le mode sécurité (Safe Mode) est actif (il l'est par défaut), la brique sélectionnée une
fois déplacée sera positionnée par dessus les autres briques.



Clic gauche -> Permet de sélectionner une ou plusieurs briques (ou groupes de briques). Un autre clic
annule la sélection.

Clic gauche + Touche [Ctrl] -> Sélectionne ou désélectionne une brique au niveau d'un groupe de
briques.

Clic gauche + Touche [Majuscule] + Touche [Ctrl] -> Coupe l'ensemble des briques sélectionnées
afin de les déplacer et les positionner à l'endroit de votre choix.

Clic gauche + Touche [Majuscule] + Touche [Alt] -> Copie l'ensemble des briques sélectionnées afin
de les déplacer et les reproduire à volonté.

Clic droit -> permet de la faire pivoter la brique en cours d'assemblage ou le sous-assemble
sélectionné. Si vous ne déplacez pas de brique, permet de changer la couleur de la brique désignée.

Clic droit + Touche [Ctrl] -> Fait pivoter de 90° la brique sélectionnée.

Touche droite [Majuscule]  + Clic droit souris -> Fait pivoter le modèle tout comme les flèches
bleues du sommet.

Clic droit + Touche [Alt] -> Affiche ou non les tenons.

Opérations à l'aide des touches du clavier

[Delete] ou [Suppr] -> Efface toutes les briques sélectionnées.

[Backspace] ou [Retour Arrière] -> Efface la brique en cours d'utilisation

[Escape] ou [Echap] -> Désélectionne les briques sélectionnées.

Touches fléchées -> Déplace la brique en cours d'utilisation d'une position X ou Y.

[Shift] + touches fléchées -> Déplace la brique en cours d'utilisation d'un tenon X ou Y.

[Insert] -> Fait pivoter la brique en cours d'utilisation de 90°.

[Page up/down] -> Déplace la brique en cours d'utilisation d'une position Z (uniquement si l'option
Safe Mode est sur off).

[Shift] + [Page up/down] -> Déplace la brique en cours d'utilisation d'un tenon Z (uniquement si
l'option Safe Mode est sur off).

[Enter] ou [Entrée] -> Pose une brique.

[F1] à [F10] -> Correspond aux différents boutons de vue dans la barre du bas.



 Le menu Configuration

Advanced Toolbox
Ouvre une boîte de dialogue.
Les options de la partie supérieure concernent uniquement les blocs sélectionnés dans la
construction. Si rien n'a été sélectionné, vos réglages n'auront aucun effet. Donc la première étape
consiste à sélectionner un ou plusieurs blocs (cf opérations à l'aide de la souris) .
Studs on/off -> l'ensemble des pièces s'affiche ou pas avec leurs tenons.
Color this piece -> l'ensemble des pièces sélectionnées s'affiche dans la couleur choisie.
Transparent -> Rend transparentes ou opaques les pièces sélectionnées.
Turn -> Fait pivoter l'ensemble des pièces sélectionnées.
Set part id -> Les utilisateurs de Ldraw peuvent poser une brique standard et changer son
numéro de référence. Cela peut s'avérer utile quand on on commence un projet Ldraw dans
BlockCAD.
Set step number -> Associe les pièces sélectionnées à une étape définies par un numéro. Quand
toutes les pièces ont été associées de la sorte, vous pouvez lancer la construction étape par étape
du modèle.
X, Y, Z -> Déplace les pièces sélectionnées dans toutes les directions possibles. Toutefois cela
n'est pas sans conséquence car des briques peuvent se retrouver emboitées de façon curieuse ce
que BlockCAD ne parviendra pas forcément à afficher alors que Ldraw le peut.

Les options de la partie inférieure s'appliquent à l'ensemble de la construction
Replace this color ->  A partir de la brique sélectionnée, remplit toutes les autres briques ayant la
même couleur avec la couleur choisie.
Use this color -> La couleur choisie s'applique à la brique sélectionnée.
Step -> Dans la mesure où toutes les pièces sont associées à une étape numérotée, vous pouvez
assister à l'élaboration du modèle pas à pas.

NOTE pour les utilisateurs de Ldraw : La fonction step est en cours de développement and n'a
pas pour l'instant de lien avec la commande '0 STEP' dans Ldraw. Plus tard probablement.

Si vous cliquez sur le bouton [Edit Ldraw info], la fenêtre s'agrandit et vous avez la possibilité
d'éditer le changement entre BlockCAD et Ldraw. Cela est seulement intéressant si vous avez
créé une nouvelle brique que vous voulez voir tracée correctemebt dans Ldraw

Ldraw this view
Ce menu n'est accessible que si vous avez installé Ldraw et avez indiqué le chemin d'accès de
l'application dans le fichier blockcad.ini. Dans ce cas, vous pouvez lancer Ldraw pour effectuer un
rendu du modèle en cours dans BlockCAD depuis le même angle de vue.
NOTE BlockCAD peut afficher des briques qui n'existent pas dans Ldraw – celles-ci seront alors
omises. Il peut également y avoir quelques erreurs dans le fichier bc2ld.lst, auquel cas le rendu ou la
position dans Ldraw ne sera pas juste.

POV (Via L2P)
Si vous avez installé Ldraw, L2P et POVRay, vous pouvez lancer un rendu directement depuis



BlockCAD. Vous aurez besoin de modifier le fichier L2PGO.BAT, et de le copier également dans le
répertoire de Ldraw.

POV (Via L3P)
Si vous avez installé Ldraw, L3P et POVRay, vous pouvez lancer un rendu directement depuis
BlockCAD. Vous aurez besoin de modifier le fichier L3PGO.BAT, et de le copier également dans le
répertoire de Ldraw.

Make group
Associe les briques sélectionnées à un groupe. De cette manière toute brique associée à un groupe se
comporte avec l'ensemble du groupe (ainsi toutes les briques du groupe sont sélectionnées dès qu'on
clique sur l'une d'entre elles). Par contre un clic associé à la touche [Ctrl] sélectionne uniquement la
brique visée. L'association d'une brique à un groupe persiste à l'ouverture ou à l'enregistrement d'un
modèle. Quand vous insérez un sous assemblage, il se comporte comme un groupe de manière à
pouvoir être déplacé entièrement lorsqu'il est sélectionné d'un simple clic gauche.

Break group
Cette option est active si au moins un groupe est sélectionné. Cela permet alors de dissocier les briques
du groupe pour les rendre à nouveau indépendantes.

Fast Studs, Better Studs, Best Studs. Permet de choisir entre différentes qualités le rendu des tenons
en privilégiant la vitesse (fast) ou la qualité (best). Cela influence aussi le rendu sous Ldraw.

Safe positioning (default *ON*)
Activer cette option oblige à ajouter des pièces uniquement par le sommet d'autres pièces. Vous ne
pourrez plus les placer dessous ou à l'intérieur d'un assemblage.

Don't render covered studs (default *OFF*)
Activer cette option peut accélérer le rendu mais il sera nécessaire de recalculer l'affichage si vous
utilisez la fonction Z-cutoff..

Slow rendering (default *OFF*)
Redessine l'image de chaque pièce à l'écran. Cette opération est plus ou moins rapide en fonction des
capacités de votre machine.

Restore background color
Restaure la couleur du fond d'écran définie par défaut dans les paramètres de Windows. Normalement
cette couleur n'est pas accessible dans BlockCAD.

Background picture…
Selectionne une image à afficher en fond d'écran. Appuyer sur [Cancel] dans le sélecteur de fichiers
enlève l'image du fond d'écran.

Hints.
Affiche ou non les aides contextuels lorsque la souris se positionne sur un bouton. 



Shading.
Permet d'afficher ou non le rendu des ombres.

Adjust light.
Ajuste la position de la source lumineuse.
NOTE: le comportement du rendu de l'ombre indique que vous avez toujours deux sources lumineuses
opposées l'une par rapport à l'autre. Donc si la lumière brille principalement sur le dessus, le dessous
est aussi allumé. 

Le menu Configuration des blocs

Ce menu contextuel est accessible par un clic droit sur le sélecteur de blocs. 
Avant d'essayer une seule de ces commandes, il est fortement recommandé de faire une copie de
sauvegarde du fichier BLOCKCAD.INI et du dossier PARTS. En cas de problème, il vous suffira de les
restaurer..

Edit -> Edite la brique.
Add -> Permet d'ajouter une nouvelle brique à partir de celle qui a été sélectionnée.
Remove -> Supprime une brique de la page.
Add page -> Ajoute une nouvelle page vide.
Add page from file… -> Lit un fichier au format .dat contenant des définitions de briques et les ajoute
dans une nouvelle page.
Remove page -> Supprime la page complète si toutes les briques ont été préalablement supprimées.
Properties -> Permet d'ajuster la hauteur des cellules et de la même manière l'échelle de la page.
Reorder pages… -> Permet de modifier l'ordre des pages.
Customize pages… -> Permet de déplacer des briques entre différentes pages.


